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AQUA™ Phoenix 
Thank you for selecting AQUA Phoenix. AQUA automates the entire Priority Dispatch System 
case review process. It assists you in everything from data entry, to compliance scoring, to 
record keeping, to reporting, and more. It helps you ensure that emergency dispatchers in your 
agency are providing quality service in compliance with all standards established by the National 
Academies of Emergency Dispatch. It pinpoints specific training needs and liability risks, and 
helps you document continuous improvement efforts. In today’s world, public safety agencies 
simply must have a defendable quality assurance program to help protect them from liability 
lawsuits. AQUA is a powerful tool that helps you meet this need with minimal commitments of 
time and personnel.  
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Installing AQUA™ Phoenix 
If you have any questions about how to install AQUA Phoenix that are not answered in the 
instructions below, please contact a member of the Priority Dispatch software support staff by 
phone at 866-777-3911 (USA/Canada) or 801-363-9127 (International) or by email at 
technical.support@prioritydispatch.net. 
You will be asked to login to AQUA each time you run the program. The system administrator 
must assign an operator login name and password to each user.  
The initial operator login name is SETUP. The initial password is AQUA. 

Requirements 
Minimum System Requirements 

Processor Speed: Pentium® III 800 MHz 
System RAM: 64 MB 
Operating System:  Microsoft® Windows® 2000 or XP (Vista not currently supported) 
Hard Disk Space: 20 MB 
Hardware Ports: Parallel Port or Available USB Port 

Software Security Key 
The AQUA software can only be run from a PC that has a parallel printer port or an available 
USB port that will support the included software security key (dongle). AQUA will not run 
unless the dongle is installed.  
Parallel port dongles can be inserted in line with other dongles and in between the printer cable 
and the port. However, no more than five dongles can be attached to any single computer. If a 
printer is connected to this same port, the printer power must be on, and the printer must be set 
to the online state, for the dongle to function properly. 
Do not remove or insert the dongle while the printer or the computer is powered on. 
Damage to the dongle and computer may occur. 

XLerator™ Server 
AQUA Phoenix 5.4 requires version 3 of the XLerator server software. You must make sure 
that XLerator 3 is installed on the local computer or on another network-accessible computer. 
Instructions for installing XLerator are included in this AQUA Phoenix Installation Guide. 

          



Installing the Software 
AQUA™ Phoenix  

1. Start Windows. If any other applications are running on your computer, close them before 
proceeding. 
Be sure you are logged on to the computer as Administrator or AQUA Phoenix will 
not install correctly. 
Please backup any data before proceeding. 

2. Place the AQUA CD-ROM into the appropriate drive of the computer. If autorun is enabled, 
the installer will begin automatically. If it does not, run setup.exe from the AQUA Phoenix 
CD-ROM. 

3. The License Agreement appears. 
 
 
 
 
 
 
 
 
 
 
 
 
Read the license agreement and then click on the OK button to Accept. 
If you do not accept this agreement, you will not be allowed to install AQUA. 
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4. The Install Software Key Drivers screen appears. 
 

 
 
 
 
 
 
 
 
If you have not previously installed the software key drivers, select Install Software Key and 
then click on the OK button. 
Follow the on-screen instructions to install the software key drivers. 

5. The Install AQUA Phoenix or XLerator screen appears. 
 

 
 
 
 
 
 
 
 
Select Install or re-install AQUA Phoenix and then click on the OK button. 
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6. The Welcome screen appears. 

 
Click on the Next button.  

7. The Customer Information dialog box appears. 

 
Enter your name along with the name and address of the organization licensed to use AQUA. 
Enter the Company Name EXACTLY as it is printed on the white sticker affixed to 
your AQUA CD case.  If you are authorized to accept the AQUA Client License and 
Service Agreement, click on the Next button 
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8. The AQUA Client License and Service Agreement dialog box appears. 

 
Read the AQUA Client License and Service Agreement. If you accept this agreement, click 
on the I ACCEPT button, and then click on the Next button. 
If you do not accept this agreement, you will not be allowed to install AQUA. 
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9. The Customer Information dialog box appears. 

 
Enter the Serial Key Number(s) EXACTLY as they are printed on the white sticker affixed 
to your AQUA CD case (including the dash), and then click on the Next button. 

10. The AQUA Phoenix Important Installation Information screen appears. 

 
 Read this important information, and then click on the Next button. 
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11. The Choose Destination Location dialog box appears. 

 
Our software support staff recommends that you use the default directory. If you choose to 
install AQUA to a directory other than the default directory, click on the Browse button, 
select the desired directory, and then click on the OK button. 
Click on the Next button. 

12. The Select Program Folder dialog box appears. 

 
The default name for the program folder is Priority Dispatch. If you want to use another 
name, enter the new name in place of Priority Dispatch. 
Click on the Next button.    
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13. The Software Installation Information screen appears. 

 
Review the information. If anything is incorrect, click on the Back button to go back and 
correct the information. If everything is correct, click on the Next button. 

14. The XLerator Instructions screen appears. 

 
Read this important information, and then click on the Next button. 
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15. The Shortcuts Reminder screen appears. 

 
Read this important information, and then click on the Next button.  

16. The Ready to Install the Program screen appears. 

 
Click on the Install button. 

17. The Setup Status screen appears. 
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18. After all files have been installed, the following information box appears. 
 

 
 
 
 
 
Click on the OK button. 

19. The InstallShield Wizard Complete screen appears. 

 
 Click on the Finish button. 
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XLerator™ 
 XLerator is designed to serve information. It can be installed locally or on a network server. 

XLerator will be accessible from all other machines in the same subnet unless restrictions are 
placed on the network. Multiple machines serving XLerator could become confusing unless 
configuration is handled or documentation made to assist in configuration. 

1. Start Windows. If any other applications are running on you computer, close them before 
proceeding. 
 Be sure you are logged on to the computer as Administrator or XLerator will not 
install correctly. 

Please backup any data before proceeding. 
2. Place the AQUA CD-ROM into the appropriate drive of the computer. If autorun is enabled, 

the installer will begin automatically. If it does not, run setup.exe from the AQUA Phoenix 
CD-ROM. 

3. The License Agreement appears. 
 

 
 
 
 
 
 
 
 
 
 
 
Read the license agreement and then click on the OK button to Accept. 
If you do not accept this agreement, you will not be allowed to install XLerator. 
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4. The Install Software Key Drivers screen appears. 
 

 
 
 
 
 
 
 
 
If you have not previously installed the software key drivers, select Install Software Key and 
then click on the OK button. 
Follow the on-screen instructions to install the software key drivers. 

5. The Install AQUA Phoenix or XLerator screen appears. 
 

 
 
 
 
 
 
 
 
Select Install or re-install XLerator v3 and then click on the OK button. 

6. The Welcome screen appears. 

 
Click on the Next button. 
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7. The Customer Information dialog box appears. 

 
Enter your name along with the name and address of the organization licensed to use AQUA, 
and then click on the Next button. 

8. The Choose Destination Location dialog box appears. 

 
Our software support staff recommends that you use the default directory. If you choose to 
install XLerator to a directory other than the default directory, click on the Browse button, 
select the desired directory, and then click on the OK button. 
Click on the Next button. 

AQUA™ Phoenix - 16 



9. The Select Program Folder dialog box appears. 

 
The default name for the program folder is Priority Dispatch. If you want to use another 
name, enter the new name in place of Priority Dispatch. 
Click on the Next button. 

10. The System Installation Information screen appears. 

 
Review the information. If anything is incorrect, click on the Back button to go back and 
correct the information. If everything is correct, click on the Next button. 
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11. The Ready to Install the Program screen appears. 

 
Click on the Install button. 

12. The Setup Status screen appears. 

 
13. After all files have been installed, the InstallShield Wizard Complete screen appears. 

 
 Click on the Finish button. 
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First-Time Setup 
XLerator™ 
1. Right-click on the XLerator icon  located in the system tray near the clock, and then click on 

Properties. 
2. The XLerator window appears. 

 
Click on the Add button. 
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3. The Alias Properties screen appears. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
4. Type an alias name for your AQUA database in the Alias field. 
 If you are creating only one database and you are running XLerator locally, our 

software support staff recommends that you use “AQUA” as your alias name. 
5. Select Aqua from the Script field. 
6. Type a database filename in the Database field. 
 If you are creating only one database and you are running XLerator locally, our 

software support staff recommends that you use “AQUA” as your database filename. 
7. Click on the OK button. 
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8. Click on the Status button on the left side of the XLerator window. 

 

Click on the Start Server button, and then close the XLerator window.  
XLerator will continue to run in the background. 

 



AQUA™ Phoenix  

1. Double-click on the AQUA Phoenix shortcut icon.  
2. The AQUA Login dialog box appears. 
 

    
 
 
 
 

Click on the More button. 
3. The AQUA Login dialog box expands. 
 

 
 
 
 
 
 
 
 
 
 
 
4. Enter the IP address of the server machine running XLerator in the Server IP Address field. 

Next, enter the port number for the server in the Server Port field. Finally, click on the  
button to select the desired database alias. 

6. After entering the appropriate database and server information, type “SETUP” in the ID 
field, type “AQUA” in the Password field, and then click on the OK button to login to 
AQUA.   

 



7. The AQUA window and AQUA Setup List screen appear. 

 
Use the AQUA Setup List and the AQUA interface to help you enter agency information, 
enter employee information, and add AQUA access users. 
Click on the bolded items in the AQUA Setup List to initiate each setup item in the 
proper order. Click on the New button on the AQUA Toolbar to enter a new record 
for each item.  
After clicking on the Add AQUA Access Users item, double click on at least one 
AQUA User in the list to create at least one Administrator account. 

8. Close AQUA. 

 



9. Double-click on the AQUA Phoenix shortcut icon.  
10. Login to AQUA using an Administrator account.  

The AQUA window and AQUA Setup List screen appear. 

 
Click on Import ProQA KQs on the AQUA Setup List. 

 



11. The Update Key Questions screen appears. 

 
Click on the Key Questions button. 

12. The Open Updates dialog box appears. 
 

 Select the appropriate language update, and then click on the Open button. 
After all Key Questions have been updated, you are ready to begin using AQUA. 

 

 



Updating to AQUA™ 
Phoenix 5.4 

You are about to update your existing data files to a new and different format.  Backup 
the data to a safe and secure place.  Then proceed with updating the data to the new 
format. 

Backup the Data Files 
Make sure you can access your data files from the machine you installed XLerator on.  You can 
back up your data several ways.  The simplest and best way, for our purposes, is to copy the 
data to a second directory.  This will allow you to start again quickly if anything goes wrong.   
Our programs will not destroy the files they work on, but if a problem arose having a quick 
copy will save a lot of time.   
If you are upgrading from AQUA v5.2 or older: 

COPY your original data file(s) to the C:\Program Files\Priority 
Dispatch\XLerator\xldb folder of the machine you installed XLerator on (assuming you 
allowed the installer to place XLerator in the default location) leaving a copy of your data in 
its original location. 

If you are upgrading from AQUA v5.3 (XLerator v2): 
Follow the instructions in the XLerator v3 Upgrade Guide to handle getting your data 
migrated. 

Working on the machine you installed XLerator onto: 
1) Click the Start button in the bottom left corner of your screen.   
 
2) Click the Programs or All Programs item in the list that appears.  
 
3) Click on Accessories, click on the Windows Explorer item.       
  
4) Navigate to the C:\Program Files\Priority Dispatch\AQUA Phoenix (5.0)\Data 

using the tree panel on the left and the file list on the right.  
If your data is located elsewhere, navigate to that folder instead. 

 
5) If you are only going to copy one file then click that file so that it highlights. If you want 

to copy several, click the first one then hold down the CTRL key and click the rest until 
you have them all highlighted. 

 



6) Click on the Edit menu item then click the Copy menu item under it.      
 
 
 
 
 
 
 
 
 
7) Navigate to the C:\Program Files\Priority Dispatch\XLerator\xldb folder using 

the folder tree in the left panel.  
 

8) Click the Edit menu item then click the Paste menu item under it. 
Your file(s) should be copied to the xldb folder. 

 
 
 
 
 
 
 
 

 
 

 



Update the Data Files Using the AQUA™ 
XLDB Updater Utility 

This brief guide will familiarize you with the utilization of the AQUA XLDB Updater utility.  
The utility will allow you to update previous AQUA databases to the latest version with only a 
couple of clicks of the mouse. 

 
1) Verify XLerator is NOT running a quick way to check is the XLerator icon will be RED 

in the task bar. 
 

2) Open the utility by running the AQUA XLDB Updater, typically located in the 
C:\Program Files\Priority Dispatch\XLerator folder. When the utility loads, you will 
see the following operation screen: 

 

 
 

 



3) Select the database you would like to update by clicking on the ellipses button next to DB 
Name field: 

 
 

4)  This will open the file explorer and allow you to select your database from wherever you 
may have it stored. Select the database you wish to update and click the ‘open’ button: 

 

 
 

5)  If the database selected is a current and valid database the following message will be 
displayed: 

 

 
 

 



Otherwise, click the ‘Update’ button: 

 
 

6)  The update will begin processing at this point and will complete, depending on size, in a 
few minutes.  When the update has been completed, the system will automatically 
generate a log file for you and reference its location: 

 

 
 

7)  Click ‘Ok’ and the utility will automatically close.  Your new database is ready to go! 
If you wish to convert another file you may start again at step #1.   

 
 

 



 

Clean Up the Data Files 
In your xldb folder there will be 2 files for each original file you started with (i.e.  AQUA.xldb 
and a file similar to 12-34-56AQUA.xldb). If you have not had any problems, delete the one 
similar to 12-34-56AQUA.xldb file. 
If you only had one data file, then we recommend that you rename it to AQUA.xldb. If you are 
converting multiple xldb files then rename each of them.  Use names that are unique and easily 
identified. 

 
1) Navigate to the xldb folder in C:\Program Files\Priority Dispatch\XLerator\xldb. 
 
2) Click on the file similar to 12-34-56AQUA.xldb and click Delete. 

 
 If you converted multiple data files you will have more backup files. 
 If you have not had any errors you may delete them now also. 

 
After deleting the backup files you should only have files that have the original 
names remaining.  You may rename them to help distinguish what they contain.   
   
1) Click the xldb file located there to select it. 
 
2) Click the File menu item and click Rename. 
 
3) Rename the file to AQUA.xldb or  

 
If you have multiple files to work with, rename them as discussed above. 
If you have more files to rename return to step #1.  
Always leave the .xldb extension at the end of the name in place. 

 
             Your data file(s) are now ready for XLerator to use. 

 



Add the Data Files to XLerator™ 
XLerator™ can now be configured to serve your data file to AQUA Phoenix.   

 
1) Right Click the XLerator icon  in your icon tray (bottom right hand side of the screen) 

then click on Properties. 
 
2) XLerator will then appear with the properties panel shown. 

 
 

 
 
 
 
 
 
 
 

3) Click the Add button to create your AQUA alias. 
 

 
 

 
 
 
 
 
 
 
A window will pop up that has two tabs, General and Maintenance. 

 
4) In the Alias box, enter the name you want to give the alias. 
 

If you intend to have only one alias, and are using AQUA and XLerator on the same 
machine and would like to make using AQUA a bit easier then name your alias AQUA. 
Otherwise name it something like “AQUASLC” (short for AQUA – Salt Lake City). 

 



 
5) Click the down arrow on the Script box to choose what type of data file this is. 

 
XLerator will be serving all of our products in the future and as a result is has several 
script options. Click on AQUA in the list. 
 

6) Now click the Existing Database to select your data file. 
 
A small window will pop up that lists the data files in your xldb folder.   
 

7) If you have only one file there click on it and then click OK. 
 
Otherwise click on the file that will go with the alias name you chose earlier, and click 
OK. 
 

8) Click the Maintenance Tab at the top of this window. 
 
 
 
 
 
 
 
 
 

9) Using the controls choose a time of day to have XLerator do a backup. 
 

10) Then click on each of the days you would like it to do a backup. 
 

11) When you are done click OK. 
 

 



12) Click on the Status button in the left hand button bar. 
                      

 
 
 
 
 
 
 
 
 

13) If the button on the status panel says Start Server click it. 
 

Otherwise it will say Stop Server, in which case you should click it to stop the server. 
Wait a moment, and click Start Server button to start the server. Close the XLerator 
window. (This will not shut down the XLerator software.) 
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